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Building Web Services
with Apache Axis2

Part I. Java-First (Bottom-Up) Services
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For live Java training, please see training courses at

http://courses.coreservlets.com/. Servlets, JSP, Struts,
JSF 1.x and JSF 2.0, Ajax, GWT, Java 5, Java 6, Spring,
Hibernate, JPA, and customized combinations of topics.

Taught by the author of Core Servlets and JSP, More
Servlets and JSP, and this tutorial. Available at public
venues, or customized versions can be held on-site at your
organization. Contact hall@coreservlets.com for details.




Agenda

Overview of Web Services
Installing Apache Axis2

Making Java-First (Bottom-Up) Web
Services

Deploying and testing your services
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Overview of Web
Services
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What are Web Services?
(Short Answer)

« A Web Serviceis aresource that
— Is accessed via HTTP (or HTTPS)
— Returns XML (SOAP)

What are Web Services?
(Long Answer from W3C)

« A Web service is a software system
— identified by a URI

— whose public interfaces and bindings are defined and
described using XML.

— Its definition can be discovered by other software
systems.

* These systems may then interact with the Web service in
a manner prescribed by its definition, using XML based
messages conveyed by Internet protocols.

— Definition from
http://www.w3.0rg/TR/wsa-reqs/#1d2604831




Web Applications vs. Web Services

« Web Apps
— Return HTML
— Take GET or POST data as input
— Result intended for a human (via a browser)
— Informal (at best) description of data that resource accepts
and result that resource returns
 Web Services
— Return XML (SOAP)
— Take XML (SOAP) as input
— Result intended for a program

— Formal definition of data that resource accepts and result
that resource returns

Web Service Advantages

Language neutrality

— Web Services define the message format, not the programming
language used

— A client does not know the language used by the service;
a service does not know the language used by the client

Interoperability

— Definition of request and response data lets any Web service interact
with any other.

Low barrier to entry

— Very simple tools for Java, Ruby, Microsoft languages, etc.
— Can write services without knowing WSDL or SOAP!
Industry support

— Very widely adopted. No danger of investing in short-lived fad ala
Ada and CORBA.




Web Service Components

« SOAP

— XML-based structure used to send and receive messages
— Originally stood for Simple Object Access Protocol
* Misleading acronym dropped in SOAP version 1.2

« WSDL

— XML-based description of a Web service
* Where it resides
« What it can do
* How to invoke it

— Stands for Web Service Description Language

 UDDI
— XML-based registry to list and find Web Services

— Stands for Universal Description, Discovery and
Integration

Apache Axis2

» Set of tools to simplify Web Services

— Services
» Create a Web service from any Java class
» Create Web service stubs from WSDL files
 Build WAR file for deployment on any Java-based server
— Clients
 Create client stubs from WSDL files
 Usage
— Eclipse plugins
* Integrated into Java EE version of Eclipse
* Download free from http://www.eclipse.org/downloads/

— Choose “Eclipse IDE for Java EE Developers”
* These tutorials will use Eclipse plugins

— Command-line tools
* Windows and Unix




Uses of Axis2

Java-First (Bottom-Up) Services
— Start with a normal Java class (POJO)
— Expose methods as Web Services
— Covered in this lecture
Clients from Java-First Services
— Build client for service built with Java-first (bottom-up) approach
— Covered in second lecture
WSDL-First (Top-Down) Services
— Start with a WSDL file
— Create Java stubs automatically
— Add business logic
— Covered in third lecture
Clients from WSDL-First Services
— Build client for service built with WSDL-first (top-down) approach
— Covered in fourth lecture
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AXIs2 Setup
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Download and Install Axis2

* Download

— Start at http://ws.apache.org/axis2/download.cgi

— Choose latest version
* This tutorial uses 1.4

— Choose "zip" under

3 arvern - - Mogilla Flrofox

B fdlt e Mgty pookmarks Lok

[
r e

o | ™ | httecfiws. anache. o fdownkosd]1_didowriosd.cp

wpache Software Foundation
m http://www.apache.org/

Standard Binary T

Distribution

e Install
— Unzip into directory
of your choice

 This tutorial uses C:\,
resulting in C:\axis2-1.4

- G-I

{aRisz

Tell Eclipse abo

« Window - Preferences = Web Services =

Axis2 Preferences

— For “Axis2 runtime ==
location”, enter 2
install path from
previous slide

— Press Apply

— Press OK

ard Val
WSDL Files

[ ¥Doclet

G XML

<

ut Axis2

Wizard Yalidation

Restors Defaults Apply I
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Building a Java-First
(Bottom-Up) Service
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e Take normal Java class (POJO)

public class Blah {
public int doFoo(String arg) { --- }
public String doBar(double arg) { ... }

}

— No special interfaces, parent classes, packages,
or method names

« Automatically expose methods as Web
Services
— Blah becomes service name
— doFoo and doBar accessible via HTTP and SOAP




Make Dynamic Web Project

 Make base project
— File > New - Project > Web - Dynamic Web Project
[- B

* Press Next

e Shortcut

— If you have previously
made a Dynamic
Web Project in that
workspace, you
can just do
New -
Dynamic Web Project

& New Project

Select a wizard

Create a Dynamic 'Web project

[ (= Plug-in Development

& Web
“S’ Drynamic Web Project
57 Static web Project
- Examples

1 Cancel

Add Axis2 Support

to Dynamic Web

 Make custom config

Project

Dynamic Web Project

— Enter a Project name

— Choose custom configuration

— Press Modify

 Add Axis2 facet
— Select checkbox for

Axis2 Web Services\

— Press OK

— Press Finish on
Dynamic Web Project
screen

Project name;

Profect conkents

Créshe & standaions Cymaime: Wb project or Sdd & bo & hew o uiiting Enberpise Appkeation.

@




Make Service Bean
(Java Class with Regular Methods)

e Create normal Java class

— No special requirements for
* Package
* Interfaces
» Superclass
« Names of methods (need not be getBlah and setBlah)
— Public methods will later become part of Web Service
* Added automatically when you make bottom-up Web
Service
» Lifecycle
— Class will be reinstantiated on each request
* S0, needs zero-argument constructor
 Fields are not persistent unless they are static

Service Bean: Example

public class StockSymbolService {
public String findCompany(String symbol) {
iIT ((isEmpty(symbol))) {
return(C*‘Missing stock symbol™);
+
String company = symbolMap.get(symbol.toUpperCase());
if (company '= null) {
return(company) ;
} else {
return(String.format(*'Unknown symbol: %s.*, symbol));
+
}

public void updateCompany(String symbol, String company) {
symbolMap.put(symbol . toUpperCase(), company);

¥




Service Bean: Example (Continued)

private static String[][] companies =
{ { "AAPL", "Apple Inc." },
"IBM", “International Business Machines Corp." },
"JAVA'™, "Sun Microsystems Inc." },
“"MSFT™, *"Microsoft Co rp. " } . Class instantiated (via zero-arg constructor) on

{ ""ORCL" B} "Oracle Co rp. " } B} every request. So, persistentqatg shoglq be static.
{ If data does not change, making it static improves
}:

"RHT™ ’ "Red Hat Inc." } performance. But in this case, updateCompany
changes the data, so it would not work at all
if the Map was a non-static instance variable.
private static“Map<String,String> symbolMap =

new HashMap<String,String>();

P

static {
for(String[] company: companies) {
symbolIMap . put(company[0], company[1]);
by

}

private boolean isEmpty(String val) {
return((val == null) || val.trim(Q).equals('""));

}

Make Web Service from
Service Bean

* Use bottom-up service
— R-click StockSymbolService.java

— New > Other - Web Services =
Web Service = Press Next
* You can also select

StockSymbolService.java and do roryen a
File > New > Other > T .
Web Services - Web Service i T
— Verify settings on Web Services wizard | =70 =]
* Bottom up service N Y% i
* service.StockSymbolService - et ik
as implementation class
* Apache Axis2 as service runtime =
— Press Finish i T
* In future, you can deploy app 1
normally (R-click server, Add and .
Remove Projects, select project, St
start server)
(T W




Verify Service is Deployed

— http://host/app-name/axis2-web/

5 Axis 2 - Home - Mozilla Firefox

Edit Bookmarks

File

Wpache Software Fou
== http://www.apache.
G- £

! 4 -
Welcome! Wpache Software Foundation
Welcome to the new generation of Axis. If you can see this page you have su " = http://www.apache.org/

warking, we encourage you to click on the validate link

View  History Tools  Help

- tar |7 | hktpijflacalhoststock-symbol-service/axis2-webj

Edit Bookmarks  Tools  Help

Yiew  Hiskory

B

- i | ] | Hetpiifacalhostistack-symbalk-service/ssrvices listServices 5

e Services

Viewghe list of all the available services deployed in this server
o Validjte
Check the systern to see whether all the required libraries are in|

& Admiistration 7
Caonsple far administering this Axis2 installation StockSymbolService

Service EPR : http:/flocalhost/stock-symbol-service/services/StockSymbolService

Available services

Service Description : Please Type your service description here

Sendce Status | Active
Available Operations

* UpdateCompany
. . . /' o findCompany
Click Services. For your service, you should # -

see a list of the public methods, now exposed Dane ¥
as Web Service operations.

Test Operations

* http://host/app-name/services/service-name/op-name?param=value

& hitp:Hlocalhost/stock-symbol-service/services/StockSymbolService/findCompany?symbol=msft - ... g@lg‘

File Edit View Favortes Took  Help e
Q- O H[E@®
address | & bttp: flocalhastfstack-symbok-service fservices/StockSymbolServiceFindCompany Psymbol=msft vE e

- «<ns:findCompanyResponse xmins:ns="http: //service">
<ns:return>=Microsoft Corp.</ns: return=
</ns: findCompanyResponse

3 hitp:Mlocalhost/stock-symbol-service/services/StockSymbolService/updateCompany?symbol=msft. .. E@”@

File  Edit Wiew Favorites Tools  Help ,."

@Done @Ba(k & ~—/ \ﬂ IEL‘ ;\J

— -
Address I@ http: fflocalhost fstock-symbal-servicefservices| Stocksymbol Service fupdasteCompariy? symbol=msftécompany=yahao ¥ | [gd Go

A hitp:Hlocalhost/stock-symbol-service/services/StockSymbolService/findCompany?symbol-msft - ... E@IF‘E

File  Edit Wiew Favorites Tools Help ,."
A

Qu-Q HEAG

Address ‘@ http:/flocalhostfstack-symbol-service/services/StockSymbolService ffind Company?symbol=msft Vi 5] Go

:g‘] Done

- <ns:findCompanyResponse xmins:ns="http://service'>
<ns:returnz=Yahoo</ns retumn:
</ns:findCompanyResponse=

@j Done ‘j Local intranet




View WSDL

2 hetp:Miacalhostistock symbol servicelservices/SlockSymbalServicehwsdl - Microsoft Internet Fxplarer

http://host/app-name/ [
services/service-name |
?2wsdl

— You can also .
click on service
name in the t
listServices page
shown earlier

nins:ws I'mn ,-",.-”qrhr'nnﬁ xm!m 1|) orgwsdl /"
tp: / forg, alpzu_hc axis2/xsd" xmins:ne="http: ,.".-"sr_ vice"
hittp:/ fwww.w3.or (IX?DOO;‘O.:," '-d(lressum/wsdl
="htp: / fschemas. xmisoap.org/wsdl /hup
hittp:/ /weww.wi.org/ 2001 /XMLSchema”
hirpe / fschemas. kmisoap.org S wsdl/mime /™
http: / /schemas, xmisoap.org/wsdl/scap/"
hnp S fachemas. kmisoap.org/wadl/soap 12,
= "http: /S serice >

riefault="qualified” elementFormbDefault="qualified"
P/ fservice' >
ndComparny’'>

2t mir ') urs="0" name="symbal" nillable="true"
string" /

Save this URL

— You will use it
when you make
a client
(see next section)

ndCompanyResponse’>

irs="0" name="return” nillable="true'

"updateCompany’ >

re="0" name="symbol" nillable="true"

rs="0" name="company" nillable="true"

onzPlease Type your service description here < fwadldocumeantations

o Lol et

Summary

Make dynamic Web project

— File & New -> Project - Web - Dynamic Web Project
Add Axis2 support

— Choose custom configuration, press Modify

— Select checkbox for Axis2 Web Services

Create normal Java class

— No special requirements

Expose class as Web Service

— R-click Java class
— New = Other = Web Services = Web Service

Deploy

— R-click server, Add and Remove Projects, select project,
start server

Test
— http://host/app-name/axis2-web/
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Questions?
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